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Autodesk Legal Notice

© 2016 Autodesk, Inc. All Rights Reserved. Except where otherwise noted, this work is licensed under a Creative Commons
Attribution-NonCommercial-ShareAlike 3.0 Unported License that can be viewed online at http://creativecommons.org/licenses/by-nc-sa/3.0/.
This license content, applicable as of 16 December 2014 to this software product, is reproduced here for offline users:

CREATIVE COMMONS CORPORATION IS NOT A LAW FIRM AND DOES NOT PROVIDE LEGAL SERVICES. DISTRIBUTION OF THIS
LICENSE DOES NOT CREATE AN ATTORNEY-CLIENT RELATIONSHIP. CREATIVE COMMONS PROVIDES THIS INFORMATION ON AN
"AS-IS" BASIS. CREATIVECOMMONSMAKESNOWARRANTIESREGARDINGTHE INFORMATIONPROVIDED, ANDDISCLAIMS LIABILITY
FOR DAMAGES RESULTING FROM ITS USE.

License

THE WORK (AS DEFINED BELOW) IS PROVIDED UNDER THE TERMS OF THIS CREATIVE COMMONS PUBLIC LICENSE ("CCPL" OR
"LICENSE"). THE WORK IS PROTECTED BY COPYRIGHT AND/OR OTHER APPLICABLE LAW. ANY USE OF THE WORK OTHER THAN
AS AUTHORIZED UNDER THIS LICENSE OR COPYRIGHT LAW IS PROHIBITED.

BY EXERCISING ANY RIGHTS TO THE WORK PROVIDED HERE, YOU ACCEPT AND AGREE TO BE BOUND BY THE TERMS OF THIS
LICENSE. TO THE EXTENT THIS LICENSE MAY BE CONSIDERED TO BE A CONTRACT, THE LICENSOR GRANTS YOU THE RIGHTS
CONTAINED HERE IN CONSIDERATION OF YOUR ACCEPTANCE OF SUCH TERMS AND CONDITIONS.

1. Definitions

a. "Adaptation"means a work based upon theWork, or upon theWork and other pre-existing works, such as a translation, adaptation, derivative
work, arrangement of music or other alterations of a literary or artistic work, or phonogram or performance and includes cinematographic
adaptations or any other form in which the Work may be recast, transformed, or adapted including in any form recognizably derived from the
original, except that a work that constitutes a Collection will not be considered an Adaptation for the purpose of this License. For the avoidance
of doubt, where the Work is a musical work, performance or phonogram, the synchronization of the Work in timed-relation with a moving image
("synching") will be considered an Adaptation for the purpose of this License.

b. "Collection" means a collection of literary or artistic works, such as encyclopedias and anthologies, or performances, phonograms or
broadcasts, or other works or subject matter other than works listed in Section 1(g) below, which, by reason of the selection and arrangement
of their contents, constitute intellectual creations, in which the Work is included in its entirety in unmodified form along with one or more other
contributions, each constituting separate and independent works in themselves, which together are assembled into a collective whole. A work
that constitutes a Collection will not be considered an Adaptation (as defined above) for the purposes of this License.

c. "Distribute" means to make available to the public the original and copies of the Work or Adaptation, as appropriate, through sale or other
transfer of ownership.

d. "License Elements" means the following high-level license attributes as selected by Licensor and indicated in the title of this License:
Attribution, Noncommercial, ShareAlike.

e. "Licensor" means the individual, individuals, entity or entities that offer(s) the Work under the terms of this License.

f. "Original Author" means, in the case of a literary or artistic work, the individual, individuals, entity or entities who created the Work or if no
individual or entity can be identified, the publisher; and in addition (i) in the case of a performance the actors, singers, musicians, dancers, and
other persons who act, sing, deliver, declaim, play in, interpret or otherwise perform literary or artistic works or expressions of folklore; (ii) in the
case of a phonogram the producer being the person or legal entity who first fixes the sounds of a performance or other sounds; and, (iii) in the
case of broadcasts, the organization that transmits the broadcast.

g. "Work" means the literary and/or artistic work offered under the terms of this License including without limitation any production in the literary,
scientific and artistic domain, whatever may be the mode or form of its expression including digital form, such as a book, pamphlet and other
writing; a lecture, address, sermon or other work of the same nature; a dramatic or dramatico-musical work; a choreographic work or entertainment
in dumb show; a musical composition with or without words; a cinematographic work to which are assimilated works expressed by a process
analogous to cinematography; a work of drawing, painting, architecture, sculpture, engraving or lithography; a photographic work to which are
assimilated works expressed by a process analogous to photography; a work of applied art; an illustration, map, plan, sketch or three-dimensional
work relative to geography, topography, architecture or science; a performance; a broadcast; a phonogram; a compilation of data to the extent
it is protected as a copyrightable work; or a work performed by a variety or circus performer to the extent it is not otherwise considered a literary
or artistic work.

h. "You" means an individual or entity exercising rights under this License who has not previously violated the terms of this License with respect
to the Work, or who has received express permission from the Licensor to exercise rights under this License despite a previous violation.

i. "Publicly Perform" means to perform public recitations of the Work and to communicate to the public those public recitations, by any means
or process, including by wire or wireless means or public digital performances; to make available to the public Works in such a way that members
of the public may access these Works from a place and at a place individually chosen by them; to perform the Work to the public by any means
or process and the communication to the public of the performances of the Work, including by public digital performance; to broadcast and
rebroadcast the Work by any means including signs, sounds or images.

j. "Reproduce" means to make copies of the Work by any means including without limitation by sound or visual recordings and the right of
fixation and reproducing fixations of the Work, including storage of a protected performance or phonogram in digital form or other electronic
medium.



2. Fair Dealing Rights. Nothing in this License is intended to reduce, limit, or restrict any uses free from copyright or rights arising from limitations
or exceptions that are provided for in connection with the copyright protection under copyright law or other applicable laws.

3. License Grant. Subject to the terms and conditions of this License, Licensor hereby grants You a worldwide, royalty-free, non-exclusive,
perpetual (for the duration of the applicable copyright) license to exercise the rights in the Work as stated below:
■ a. to Reproduce the Work, to incorporate the Work into one or more Collections, and to Reproduce

the Work as incorporated in the Collections;

■ b. to create and Reproduce Adaptations provided that any such Adaptation, including any translation
in any medium, takes reasonable steps to clearly label, demarcate or otherwise identify that changes
were made to the original Work. For example, a translation could be marked "The original work was
translated from English to Spanish," or a modification could indicate "The original work has been
modified.";

■ c. to Distribute and Publicly Perform the Work including as incorporated in Collections; and,

■ d. to Distribute and Publicly Perform Adaptations.

The above rights may be exercised in all media and formats whether now known or hereafter devised. The above rights include the right to make
such modifications as are technically necessary to exercise the rights in other media and formats. Subject to Section 8(f), all rights not expressly
granted by Licensor are hereby reserved, including but not limited to the rights described in Section 4(e).

4. Restrictions. The license granted in Section 3 above is expressly made subject to and limited by the following restrictions:
■ a. You may Distribute or Publicly Perform the Work only under the terms of this License. You must

include a copy of, or the Uniform Resource Identifier (URI) for, this License with every copy of the
Work You Distribute or Publicly Perform. You may not offer or impose any terms on the Work that
restrict the terms of this License or the ability of the recipient of the Work to exercise the rights granted
to that recipient under the terms of the License. You may not sublicense the Work. You must keep
intact all notices that refer to this License and to the disclaimer of warranties with every copy of the
Work You Distribute or Publicly Perform. When You Distribute or Publicly Perform the Work, You may
not impose any effective technological measures on the Work that restrict the ability of a recipient of
the Work from You to exercise the rights granted to that recipient under the terms of the License. This
Section 4(a) applies to the Work as incorporated in a Collection, but this does not require the Collection
apart from the Work itself to be made subject to the terms of this License. If You create a Collection,
upon notice from any Licensor You must, to the extent practicable, remove from the Collection any
credit as required by Section 4(d), as requested. If You create an Adaptation, upon notice from any
Licensor You must, to the extent practicable, remove from the Adaptation any credit as required by
Section 4(d), as requested.

■ b. You may Distribute or Publicly Perform an Adaptation only under: (i) the terms of this License; (ii)
a later version of this License with the same License Elements as this License; (iii) a Creative Commons
jurisdiction license (either this or a later license version) that contains the same License Elements as
this License (e.g., Attribution-NonCommercial-ShareAlike 3.0 US) ("Applicable License"). You must
include a copy of, or the URI, for Applicable License with every copy of each Adaptation You Distribute
or Publicly Perform. You may not offer or impose any terms on the Adaptation that restrict the terms
of the Applicable License or the ability of the recipient of the Adaptation to exercise the rights granted
to that recipient under the terms of the Applicable License. You must keep intact all notices that refer
to the Applicable License and to the disclaimer of warranties with every copy of the Work as included
in the Adaptation You Distribute or Publicly Perform. When You Distribute or Publicly Perform the
Adaptation, You may not impose any effective technological measures on the Adaptation that restrict
the ability of a recipient of the Adaptation from You to exercise the rights granted to that recipient
under the terms of the Applicable License. This Section 4(b) applies to the Adaptation as incorporated
in a Collection, but this does not require the Collection apart from the Adaptation itself to be made
subject to the terms of the Applicable License.



■ c. You may not exercise any of the rights granted to You in Section 3 above in any manner that is
primarily intended for or directed toward commercial advantage or private monetary compensation.
The exchange of the Work for other copyrighted works by means of digital file-sharing or otherwise
shall not be considered to be intended for or directed toward commercial advantage or private monetary
compensation, provided there is no payment of any monetary compensation in connection with the
exchange of copyrighted works.

■ d. If You Distribute, or Publicly Perform the Work or any Adaptations or Collections, You must, unless
a request has been made pursuant to Section 4(a), keep intact all copyright notices for the Work and
provide, reasonable to the medium or means You are utilizing: (i) the name of the Original Author (or
pseudonym, if applicable) if supplied, and/or if the Original Author and/or Licensor designate another
party or parties (e.g., a sponsor institute, publishing entity, journal) for attribution ("Attribution Parties")
in Licensor's copyright notice, terms of service or by other reasonable means, the name of such party
or parties; (ii) the title of the Work if supplied; (iii) to the extent reasonably practicable, the URI, if any,
that Licensor specifies to be associated with the Work, unless such URI does not refer to the copyright
notice or licensing information for the Work; and, (iv) consistent with Section 3(b), in the case of an
Adaptation, a credit identifying the use of the Work in the Adaptation (e.g., "French translation of the
Work by Original Author," or "Screenplay based on original Work by Original Author"). The credit
required by this Section 4(d) may be implemented in any reasonable manner; provided, however, that
in the case of a Adaptation or Collection, at a minimum such credit will appear, if a credit for all
contributing authors of the Adaptation or Collection appears, then as part of these credits and in a
manner at least as prominent as the credits for the other contributing authors. For the avoidance of
doubt, You may only use the credit required by this Section for the purpose of attribution in the manner
set out above and, by exercising Your rights under this License, You may not implicitly or explicitly
assert or imply any connection with, sponsorship or endorsement by the Original Author, Licensor
and/or Attribution Parties, as appropriate, of You or Your use of the Work, without the separate, express
prior written permission of the Original Author, Licensor and/or Attribution Parties.

■ e. For the avoidance of doubt:
■ i. Non-waivable Compulsory License Schemes. In those jurisdictions in which the right to collect

royalties through any statutory or compulsory licensing scheme cannot be waived, the Licensor
reserves the exclusive right to collect such royalties for any exercise by You of the rights granted
under this License;

■ ii. Waivable Compulsory License Schemes. In those jurisdictions in which the right to collect royalties
through any statutory or compulsory licensing scheme can be waived, the Licensor reserves the
exclusive right to collect such royalties for any exercise by You of the rights granted under this
License if Your exercise of such rights is for a purpose or use which is otherwise than noncommercial
as permitted under Section 4(c) and otherwise waives the right to collect royalties through any
statutory or compulsory licensing scheme; and,

■ iii. Voluntary License Schemes. The Licensor reserves the right to collect royalties, whether
individually or, in the event that the Licensor is a member of a collecting society that administers
voluntary licensing schemes, via that society, from any exercise by You of the rights granted under
this License that is for a purpose or use which is otherwise than noncommercial as permitted under
Section 4(c).

■ f. Except as otherwise agreed in writing by the Licensor or as may be otherwise permitted by applicable
law, if You Reproduce, Distribute or Publicly Perform the Work either by itself or as part of any
Adaptations or Collections, You must not distort, mutilate, modify or take other derogatory action in
relation to the Work which would be prejudicial to the Original Author's honor or reputation. Licensor
agrees that in those jurisdictions (e.g. Japan), in which any exercise of the right granted in Section 3(b)



of this License (the right to make Adaptations) would be deemed to be a distortion, mutilation,
modification or other derogatory action prejudicial to the Original Author's honor and reputation, the
Licensor will waive or not assert, as appropriate, this Section, to the fullest extent permitted by the
applicable national law, to enable You to reasonably exercise Your right under Section 3(b) of this
License (right to make Adaptations) but not otherwise.

5. Representations, Warranties and Disclaimer

UNLESSOTHERWISEMUTUALLYAGREEDTOBYTHEPARTIES INWRITINGANDTOTHEFULLESTEXTENTPERMITTEDBYAPPLICABLE
LAW, LICENSOR OFFERS THE WORK AS-IS AND MAKES NO REPRESENTATIONS ORWARRANTIES OF ANY KIND CONCERNING THE
WORK, EXPRESS, IMPLIED, STATUTORY OR OTHERWISE, INCLUDING, WITHOUT LIMITATION, WARRANTIES OF TITLE,
MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE, NONINFRINGEMENT, OR THE ABSENCE OF LATENT OR OTHER
DEFECTS, ACCURACY, OR THE PRESENCE OF ABSENCE OF ERRORS, WHETHER OR NOT DISCOVERABLE. SOME JURISDICTIONS
DO NOT ALLOW THE EXCLUSION OF IMPLIED WARRANTIES, SO THIS EXCLUSION MAY NOT APPLY TO YOU.

6. Limitation on Liability. EXCEPT TO THE EXTENT REQUIRED BY APPLICABLE LAW, IN NO EVENT WILL LICENSOR BE LIABLE TO
YOU ON ANY LEGAL THEORY FOR ANY SPECIAL, INCIDENTAL, CONSEQUENTIAL, PUNITIVE OR EXEMPLARY DAMAGES ARISING
OUTOFTHIS LICENSEORTHEUSEOFTHEWORK, EVEN IF LICENSORHASBEENADVISEDOFTHEPOSSIBILITYOFSUCHDAMAGES.

7. Termination
■ a. This License and the rights granted hereunder will terminate automatically upon any breach by You

of the terms of this License. Individuals or entities who have received Adaptations or Collections from
You under this License, however, will not have their licenses terminated provided such individuals or
entities remain in full compliance with those licenses. Sections 1, 2, 5, 6, 7, and 8 will survive any
termination of this License.

■ b. Subject to the above terms and conditions, the license granted here is perpetual (for the duration of
the applicable copyright in the Work). Notwithstanding the above, Licensor reserves the right to release
the Work under different license terms or to stop distributing the Work at any time; provided, however
that any such election will not serve to withdraw this License (or any other license that has been, or is
required to be, granted under the terms of this License), and this License will continue in full force and
effect unless terminated as stated above.

8. Miscellaneous
■ a. Each time You Distribute or Publicly Perform the Work or a Collection, the Licensor offers to the

recipient a license to the Work on the same terms and conditions as the license granted to You under
this License.

■ b. Each time You Distribute or Publicly Perform an Adaptation, Licensor offers to the recipient a license
to the original Work on the same terms and conditions as the license granted to You under this License.

■ c. If any provision of this License is invalid or unenforceable under applicable law, it shall not affect
the validity or enforceability of the remainder of the terms of this License, and without further action
by the parties to this agreement, such provision shall be reformed to the minimum extent necessary
to make such provision valid and enforceable.

■ d. No term or provision of this License shall be deemed waived and no breach consented to unless such
waiver or consent shall be in writing and signed by the party to be charged with such waiver or consent.

■ e. This License constitutes the entire agreement between the parties with respect to the Work licensed
here. There are no understandings, agreements or representations with respect to the Work not specified
here. Licensor shall not be bound by any additional provisions that may appear in any communication
from You. This License may not be modified without the mutual written agreement of the Licensor
and You.

■ f. The rights granted under, and the subject matter referenced, in this License were drafted utilizing
the terminology of the Berne Convention for the Protection of Literary and Artistic Works (as amended
on September 28, 1979), the Rome Convention of 1961, the WIPO Copyright Treaty of 1996, the WIPO



Performances and Phonograms Treaty of 1996 and the Universal Copyright Convention (as revised on
July 24, 1971). These rights and subject matter take effect in the relevant jurisdiction in which the
License terms are sought to be enforced according to the corresponding provisions of the implementation
of those treaty provisions in the applicable national law. If the standard suite of rights granted under
applicable copyright law includes additional rights not granted under this License, such additional
rights are deemed to be included in the License; this License is not intended to restrict the license of
any rights under applicable law.

Creative Commons Notice

Creative Commons is not a party to this License, and makes no warranty whatsoever in connection with the Work. Creative Commons will not
be liable to You or any party on any legal theory for any damages whatsoever, including without limitation any general, special, incidental or
consequential damages arising in connection to this license. Notwithstanding the foregoing two (2) sentences, if Creative Commons has expressly
identified itself as the Licensor hereunder, it shall have all rights and obligations of Licensor.

Except for the limited purpose of indicating to the public that the Work is licensed under the CCPL, Creative Commons does not authorize the
use by either party of the trademark "Creative Commons" or any related trademark or logo of Creative Commons without the prior written consent
of Creative Commons. Any permitted use will be in compliance with Creative Commons' then-current trademark usage guidelines, as may be
published on its website or otherwise made available upon request from time to time. For the avoidance of doubt, this trademark restriction does
not form part of this License.

Creative Commons may be contacted at http://creativecommons.org/.

Certain materials included in this publication are reprinted with the permission of the copyright holder.

Creative Commons FAQ

Autodesk's Creative Commons FAQ can be viewed online at http://www.autodesk.com/company/creative-commons, and is reproduced here for
offline users.

In collaboration with Creative Commons, Autodesk invites you to share your knowledge with the rest of the world, inspiring others to learn,
achieve goals, and ignite creativity. You can freely borrow from the Autodesk Help, Support and Video libraries to build a new learning experience
for anyone with a particular need or interest.

What is Creative Commons?

Creative Commons (CC) is a nonprofit organization that offers a simple licensing model that frees digital content to enable anyone to modify,
remix, and share creative works.

How do I know if Autodesk learning content and Autodesk University content is available under Creative Commons?

All Autodesk learning content and Autodesk University content released under Creative Commons is explicitly marked with a Creative Commons
icon specifying what you can and cannot do. Always follow the terms of the stated license.

What Autodesk learning content is currently available under Creative Commons?

Over time, Autodesk will release more and more learning content under the Creative Commons licenses.

Currently available learning content:
■ Autodesk online help-Online help for many Autodesk products, including its embedded media such

as images and help movies.

■ Autodesk Learning Videos-A range of video-based learning content, including the video tutorials on
the Autodesk YouTube™ Learning Channels and their associated iTunes® podcasts.

■ Autodesk downloadable materials-Downloadable 3D assets, digital footage, and other files you can use
to follow along on your own time.

Is Autodesk learning and support content copyrighted?

Yes. Creative Commons licensing does not replace copyright. Copyright remains with Autodesk or its suppliers, as applicable. But it makes the
terms of use much more flexible.

What do the Autodesk Creative Commons licenses allow?

HTTP://CREATIVECOMMONS.ORG/


Autodesk makes some of its learning and support content available under two distinct Creative Commons licenses. The learning content is
clearly marked with the applicable Creative Commons license. You must comply with the following conditions:

■ Attribution-NonCommercial-ShareAlike (CC BY-NC-SA) This license lets you copy, distribute, display,
remix, tweak, and build upon our work noncommercially, as long as you credit Autodesk and license
your new creations under the identical terms.

■ Attribution-NonCommercial-No Derivative Works (CC BY-NC-ND) This license lets you copy, distribute,
and display only verbatim copies of our work as long as you credit us, but you cannot alter the learning
content in any way or use it commercially.

■ Special permissions on content marked as No Derivative Works For video-based learning content
marked as No Derivative Works (ND), Autodesk grants you special permission to make modifications
but only for the purpose of translating the video content into another language.

These conditions can be modified only by explicit permission of Autodesk, Inc. Send requests for modifications outside of these license terms
to creativecommons@autodesk.com.

Can I get special permission to do something different with the learning content?

Unless otherwise stated, our Creative Commons conditions can be modified only by explicit permission of Autodesk, Inc. If you have any questions
or requests for modifications outside of these license terms, email us at creativecommons@autodesk.com.

How do I attribute Autodesk learning content?

You must explicitly credit Autodesk, Inc., as the original source of the materials. This is a standard requirement of the Attribution (BY) term in
all Creative Commons licenses. In some cases, such as for the Autodesk video learning content, we specify exactly how we would like to be
attributed.

This is usually described on the video's end-plate. For the most part providing the title of the work, the URL where the work is hosted, and a
credit to Autodesk, Inc., is quite acceptable. Also, remember to keep intact any copyright notice associated with the work. This may sound like
a lot of information, but there is flexibility in the way you present it.

Here are some examples:

"This document contains content adapted from the Autodesk®Maya®Help, available under a Creative Commons Attribution-NonCommercial-Share
Alike license. Copyright © Autodesk, Inc."

"This is a Finnish translation of a video created by the Autodesk Maya Learning Channel @ www.youtube.com/mayahowtos. Copyright ©
Autodesk, Inc."

"Special thanks to the Autodesk® 3ds Max® Learning Channel @ www.youtube.com/3dsmaxhowtos. Copyright © Autodesk, Inc."

Do I follow YouTube's standard license or Autodesk's Creative Commons license?

The videos of the Autodesk Learning Channels on YouTube are uploaded under YouTube's standard license policy. Nonetheless, these videos
are released by Autodesk as Creative Commons Attribution-NonCommercial-No Derivative Works (CC BY-NC-ND) and are marked as such.

You are free to use our video learning content according to the Creative Commons license under which they are released.

Where can I easily download Autodesk learning videos?

Most of the Autodesk Learning Channels have an associated iTunes podcast from where you can download the same videos and watch them
offline. When translating Autodesk learning videos, we recommend downloading the videos from the iTunes podcasts.

Can I translate Autodesk learning videos?

Yes. Even though our learning videos are licensed as No Derivative Works (ND), we grant everyone permission to translate the audio and
subtitles into other languages. In fact, if you want to recapture the video tutorial as-is but show the user interface in another language, you are
free to do so. Be sure to give proper attribution as indicated on the video's Creative Commons end-plate. This special permission only applies
to translation projects. Requests for modifications outside of these license terms can be directed to creativecommons@autodesk.com.

How do I let others know that I have translated Autodesk learning content into another language?

Autodesk is happy to see its learning content translated into as many different languages as possible. If you translate our videos or any of our
learning content into other languages, let us know. We can help promote your contributions to our growing multilingual community. In fact, we
encourage you to find creative ways to share our learning content with your friends, family, students, colleagues, and communities around the
world. Contact us at creativecommons@autodesk.com.

I have translated Autodesk learning videos into other languages. Can I upload them to my own YouTube channel?

Yes, please do and let us know where to find them so that we can help promote your contributions to our growing multilingual Autodesk community.
Contact us at creativecommons@autodesk.com.

Can I repost or republish Autodesk learning content on my site or blog?

HTTP://WWW.YOUTUBE.COM/MAYAHOWTOS
HTTP://WWW.YOUTUBE.COM/3DSMAXHOWTOS


Yes, you can make Autodesk learning material available on your site or blog as long as you follow the terms of the Creative Commons license
under which the learning content is released. If you are simply referencing the learning content as-is, then we recommend that you link to it or
embed it from where it is hosted by Autodesk. That way the content will always be fresh. If you have translated or remixed our learning content,
then by all means you can host it yourself. Let us know about it, and we can help promote your contributions to our global learning community.
Contact us at creativecommons@autodesk.com.

Can I show Autodesk learning content during my conference?

Yes, as long as it's within the scope of a noncommercial event, and as long as you comply with the terms of the Creative Commons license
outlined above. In particular, the videos must be shown unedited with the exception of modifications for the purpose of translation. If you wish
to use Autodesk learning content in a commercial context, contact us with a request for permission at creativecommons@autodesk.com.

Can I use Autodesk learning content in my classroom?

Yes, as long as you comply with the terms of the Creative Commons license under which the learning material is released. Many teachers use
Autodesk learning content to stimulate discussions with students or to complement course materials, and we encourage you to do so as well.

Can I re-edit and remix Autodesk video learning content?

No, but for one exception. Our Creative Commons BY-NC-ND license clearly states that "derivative works" of any kind (edits, cuts, remixes,
mashups, and so on) are not allowed without explicit permission from Autodesk. This is essential for preserving the integrity of our instructors'
ideas. However, we do give you permission to modify our videos for the purpose of translating them into other languages.

Can I re-edit and remix Autodesk downloadable 3D assets and footage?

Yes. The Autodesk Learning Channels on YouTube provide downloadable 3D assets, footage, and other files for you to follow along with the
video tutorials on your own time. This downloadable material is made available under a Creative Commons Attribution-NonCommercial-ShareAlike
(CC BY-NC-SA) license. You can download these materials and experiment with them, but your remixes must give us credit as the original
source of the content and be shared under the identical license terms.

Can I use content from Autodesk online help to create new materials for a specific audience?

Yes, if you want to help a specific audience learn how to optimize the use of their Autodesk software, there is no need to start from scratch. You
can use, remix, or enrich the relevant help content and include it in your book, instructions, examples, or workflows you create, then Share-Alike
with the community. Always be sure to comply with the terms of the Creative Commons license under which the learning content is released.

What are the best practices for marking content with Creative Commons Licenses?

When reusing a CC-licensed work (by sharing the original or a derivative based on the original), it is important to keep intact any copyright notice
associated with the work, including the Creative Commons license being used. Make sure you abide by the license conditions provided by the
licensor, in this case Autodesk, Inc.

Trademarks

The following are registered trademarks or trademarks of Autodesk, Inc., and/or its subsidiaries and/or affiliates in the USA and other countries:
123D, 3ds Max, Alias, ATC, AutoCAD LT, AutoCAD, Autodesk, the Autodesk logo, Autodesk 123D, Autodesk Homestyler, Autodesk Inventor,
Autodesk MapGuide, Autodesk Streamline, AutoLISP, AutoSketch, AutoSnap, AutoTrack, Backburner, Backdraft, Beast, BIM 360, Burn, Buzzsaw,
CADmep, CAiCE, CAMduct, Civil 3D, Combustion, Communication Specification, Configurator 360, Constructware, Content Explorer, Creative
Bridge, Dancing Baby (image), DesignCenter, DesignKids, DesignStudio, Discreet, DWF, DWG, DWG (design/logo), DWG Extreme, DWG
TrueConvert, DWG TrueView, DWGX, DXF, Ecotect, Ember, ESTmep, FABmep, Face Robot, FBX, Fempro, Fire, Flame, Flare, Flint, ForceEffect,
FormIt 360, Freewheel, Fusion 360, Glue, Green Building Studio, Heidi, Homestyler, HumanIK, i-drop, ImageModeler, Incinerator, Inferno,
InfraWorks, Instructables, Instructables (stylized robot design/logo), Inventor, Inventor HSM, Inventor LT, Lustre, Maya, Maya LT, MIMI, Mockup
360, Moldflow Plastics Advisers, Moldflow Plastics Insight, Moldflow, Moondust, MotionBuilder, Movimento, MPA (design/logo), MPA, MPI
(design/logo), MPX (design/logo), MPX, Mudbox, Navisworks, ObjectARX, ObjectDBX, Opticore, P9, Pier 9, Pixlr, Pixlr-o-matic, Productstream,
Publisher 360, RasterDWG, RealDWG, ReCap, ReCap 360, Remote, Revit LT, Revit, RiverCAD, Robot, Scaleform, Showcase, Showcase 360,
SketchBook, Smoke, Socialcam, Softimage, Spark & Design, Spark Logo, Sparks, SteeringWheels, Stitcher, Stone, StormNET, TinkerBox,
Tinkercad, Tinkerplay, ToolClip, Topobase, Toxik, TrustedDWG, T-Splines, ViewCube, Visual LISP, Visual, VRED,Wire, Wiretap, WiretapCentral,
XSI.

All other brand names, product names or trademarks belong to their respective holders.

Disclaimer

THIS PUBLICATION AND THE INFORMATION CONTAINED HEREIN IS MADE AVAILABLE BY AUTODESK, INC. "AS IS." AUTODESK, INC.
DISCLAIMS ALL WARRANTIES, EITHER EXPRESS OR IMPLIED, INCLUDING BUT NOT LIMITED TO ANY IMPLIED WARRANTIES OF
MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE REGARDING THESE MATERIALS.
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Alias 2017 の新機能

このたび、Autodesk® Alias™ソフトウェアの最新バージョンをご提供することになりました。

このガイドは、Alias 2017の新機能および変更された機能について説明します。
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全体的な改良点

全体的な変更点と新しい機能について説明します。

一般的な免責条項

以前のバージョンの Aliasからの既存のユーザ設定を使用している場合は、オプションの既定値
が変更されたことに気づかない場合があります。

Windows のユーザ設定は、C:¥Users¥<ユーザ名
>AppData¥Roaming¥Autodesk¥Alias¥UserPrefs2017にあります。

Mac OS のユーザ設定は、/Users/<ユーザ名>/Library/Preferences/Autodesk/Alias/UserPrefs2017
にあります。

このフォルダが存在しない場合、20172017 の初回起動時にフォルダが作成されます。次のダイ
アログが表示されます。

Defaultsを選択し、新しい既定の設定を受け入れます。

ライセンスに対する変更

スタンドアロンインストールを行うときのインストールプロセスで、シリアル番号と製品コー

ドを入力しなくなりました。代わりに、最初にソフトウェアを起動するときに、次の情報を入力
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します。オートデスク製品のライセンスの詳細については、「ライセンスを管理する」を参照

してください。

パフォーマンスの改善と最適化

オートデスクは 2017 のパフォーマンスの改善と最適化を行い、次の処理を高速化しました。

■ 大きいファイルのロード

■ 大規模モデルの削除

■ バリアントの切り替え

■ Hide Unselectedを使用した表示/非表示の切り替え

■ グローバル断面の作成、削除、およびタンブル

■ レイヤ選択のような Object Lister アクション

Variant Lister の機能強化

■ ホットキーを使用して、Variant Lister を開かずにバリアントを切り替える方法がサポート
されるようになりました。

Preferences > Interface > Hotkeys/Menu Editorの順に選択し、Variant Lister セ
クションで特定のバリアント、および次のバリアント操作のホットキーを設定します。

Display Next in Group、Display Prev in Group、Delete Current Variant、
Cycle Variants in Group、Capture New Variant in Group。

■ バリアントが再生されるまでの待機時間中にコントロールできるようになりました。

Variant Lister ウィンドウのメニューバーの最初のスライダをドラッグすると、バリアント
が表示されるまでの待機秒数を変更できます。
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右クリックメニューを使用して、レイヤをレイヤフォルダに割り当てます。

Object Lister でレイヤをレイヤフォルダにレイヤを割り当てる際に、右クリックメニューを使
用できるようになりました。

割り当てるレイヤを選択し、レイヤフォルダを右クリックして Assign Layersを選択しま
す。

注視点(POI)の機能強化

■ POI をオンまたはオフに設定する代わりに、General Preferences ダイアログボックスの
Viewing セクションで、次のように POI の動作を設定できるようになりました。

■ None – 注視点はありません。シーンの原点を中心にカメラが動きます。

■ Dynamic – POI は非表示になり、[Shift]+[Alt]+ 左矢印キーを押すか、オブジェクトを
右クリックするたびに設定されます。

■ Persistent – POI は表示され、[Shift]+[Alt]を押しながらオブジェクトをクリックする
たびに設定されます。このオプションが選択されている場合は、Show Point of
Interest Jackおよび Dolly to Pointオプションが利用可能になります。

Show Point of Interest Jackが選択されていない場合は、最初に設定したときのみ
POI が表示されます。それ以降のタンブルでは POI は表示されません。
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■ メッシュとメッシュの対称側、およびシェルとシェルの対称側(シンメトリをオンにしたレ

イヤ上)に POI を設定できるようになりました。

■ モデルのワイヤフレームがオフの場合は、POI をシェードされたメッシュ上に設定できま
す。

ビューを反転する機能

X 軸に沿ってビューを反転できるようになりました。

View > View Flipを選択します。

ビューと反転されたビューを両方同時に表示するには、View > View Bothを選択します。

ホットキーエディタの Special > Display Functionsで View Flipのホットキーを設定し
ます。

注: 反転されたビューで操作している場合は、マウス操作が中断されます。ビューおよびマウ
ス操作を復元するには、このツールを再度選択します。
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印刷の機能強化

■ 2 つの新しい Viewタイプ(4 Viewsと Current Layout)が追加されました。

■ View Optionsに次のオプションがあります。
■ 新しいWindow Bordersオプション: 選択した Viewウィンドウの周りに線を追加
します。

■ 新しい Fix Bright Colorsオプション: 白の背景で表示されない場合は、色を自動的
に暗くします。

■ Print Preview でビューのサイズを変更し、パンする機能: Print ダイアログを閉じるか、別
のアプリケーションに書き出してからでなくても、レイアウトをカスタマイズできます。

View で Free Formを選択します。

ビューのエッジをドラッグして、サイズを変更します。ビューウィンドウをドラッグして、

ページ上のビューを移動します。

■ ドロップダウンプリンタリストを表示し、プリンタ名の上にカーソルを置いて、ツール

チップにプリンタ名全体を表示します。

■ Current Layoutで拡大ビューを印刷することができます。

■ バグ修正:

■ RasterとVectorモードを切り替えた場合、グリッドオプションが維持されるように
なりました。

■ 印刷後に ViewCube が移動しなくなりました。

SiemensTeamcenter との統合

オートデスクコンサルティングサービスを通して Teamcenter との統合を利用できるように
なりました。
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モデリング

モデリングツールへの変更と改善点について説明します。

新しい Freeform Curve Blend ツール

他の Alias ツール(Surface Fillet や Freeform Blend)で使用されるのと同じフォームファクタコ
ントロールを使用してカーブとサーフェスエッジ間のブレンドを行う、カーブを作成するため

Freeform Curve Blend ツールが追加されました。

3
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フリーフォームカーブブレンドを作成するには

1 Curve Edit > Create > Freeform Curve Blend ❑を選択します。

2 カーブブレンドを開始するカーブまたはサーフェスエッジを選択します。

3 必要に応じて、正確な位置にカーブブレンドポイントをドラッグします。

4 カーブブレンドを終了するカーブまたはサーフェスエッジを選択します。

5 必要に応じて、正確な位置にカーブブレンドポイントをドラッグします。

6 ブレンドの各側で目的の Continuityおよび Alignmentを設定し、Blend Control
オプションを設定します。

7 Buildをクリックします。

Freeform Curve Blend Control オプション

Side A/B Continuity

G0 Position、G1 Tangent、G2 curvature または G3 curvature を選択して、カーブブレンド
とプライマリカーブ間に使用する連続性タイプを決定します。両方の境界セットに沿って、連

続性設定を独立して指定することができます。

G2 曲率連続性は、曲率(曲率の半径の逆)がカーブの境界の両側で同じであることを意味しま
す。カーブブレンドの V 次数は、カーブの CV が十分で、両側で必要な連続性が得られるよ
うに調整されます。片側の G2 連続性には次数 4 が必要です。両側の G2 連続性には次数 5 が
必要です。

G3 曲率連続性は、曲率の変化率がカーブの境界の両側で同じであることを意味します。カー
ブの V 次数は、カーブの CV が十分で、両側で必要な連続性が得られるように調整されます。
片側の G3 連続性には次数 6 が必要です。両側の G3 連続性には次数 7 が必要です。

Side A/B Alignment

Curve Flow – ブレンドポイントのプライマリカーブのパスに沿ってカーブブレンドを位置
揃えします。

Perpendicular – ブレンドポイントのプライマリカーブと垂直になるようにカーブブレン
ドを位置揃えします。

Surface Flow – カーブブレンドをアイソパラムに位置揃えして、ブレンドポイントでエッ
ジまたはカーブオンサーフェスに対する平行度が最小となるようにします。

Connect – 反対側のブレンドポイントと 1 列になるように、ブレンドポイントのプライマリ
カーブにカーブブレンドを位置揃えします。
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Planar カーブ上のすべてのポイントが同一平面上になるように、サイド A ブレンドポイント
からカーブを作成します。

Closest Point サイド B ブレンドポイントはサイド A ブレンドポイントに最も近いポイント
になります。

Blend Control

このオプションは、Side A および Side B Continuity が同一(G1 Tangent、G2 Curvature、ま
たは G3 Curvature only)である場合にのみ使用できます。

ブレンドのシェイプのコントロール方法を  Form Factorまたは Shapeから選択します。

Form Factor を選択するには、両側が G1 連続性以上である必要があります。

Shape Controls を選択するには、少なくとも片側が G1 連続性以上である必要があります。

Form Factor

ブレンドのシェイプを調整できます。ハルの最も内側の CV アームと最も外側の CV アームの
長さの比率を指定します。値の範囲は 0.1 から 2.0 です。値を小さくすると、ブレンドの曲げ
が急になります。

Lock Shape Controls

このオプションが選択されている場合、Side A Shape と Side B Shape の値は同じになります。

Side A Shape

1 つ目の境界に対するカーブブレンドの「緩さ」または「堅さ」をコントロールできます。値
が 1.0 より大きい場合、入力カーブのコーナーにより密接したブレンドになります。値が 1.0
より小さい場合、1 つ目のカーブのエッジに近似した、より丸みを帯びたブレンドになります。

Side B Shape

2 つ目の境界に対するカーブブレンドの「緩さ」または「堅さ」をコントロールできます。値
が 1.0 より大きい場合、入力カーブのコーナーにより密接したブレンドになります。値が 1.0
より小さい場合、2 つ目のカーブのエッジに近似した、より丸みを帯びたブレンドになります。

Auto Update オプションを変更した場合に、カーブブレンドを自動的に更新します。

MS Draft ツールの機能強化

新しい Draft Radial Refit オプション

Refit
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Radialオプションを選択すると、元のドラフトサーフェスのバリエーションが作成されま
す。ただし、ラジアルサーフェスはドラフトベクトルの方向に従わないため、ラジアルドラ

フトサーフェスによってはドラフト要件を満たさないことがあります。(Surface Evaluation
ダイアグノスティックシェーダのドラフト角度チェックに失敗します。既定の非ラジアルド

ラフトサーフェスとラジアルドラフトサーフェス間の角度が大きいほど、ドラフトチェック

に失敗する可能性が大きくなります。)

ドラフト要件を満たすラジアルドラフトサーフェスを作成するために、Refitオプションは
ラジアル方向に引き続き従いながら、ラジアルサーフェスを元のドラフトサーフェスに再

フィットさせようとします。これにより、ラジアルドラフトサーフェスのドラフトサーフェ

スの長さ(V)方向の次数が 2 に変更され、既定の非ラジアルドラフトサーフェスに合わせてラ
ジアルドラフトエッジの CV の上部行が位置揃えされて、クラウンが作成されます。作成さ
れたラジアルサーフェスは元のサーフェスに近づくため、Surface Evaluation ダイアグノス
ティックシェーダのチェック結果がさらに良好になります。

注: この方法で成功する場合と、成功しない場合があります。

新しい Draft/Flange Proportional Crown オプション

Proportional Crown

このオプションを選択すると、サーフェスの高さまたはクラウンが元のカーブとドラフトサー

フェスの上部間の距離に比例するように、ドラフトサーフェスの中点または上部を上げ下げで

きます。

サーフェス上で直接 Proportional Crown をオン/オフにすることができます。

■ クラウンマニピュレータを表示するには、Off をクリックします。

■ クラウンの値を変更するには、矢印をドラッグします。0.005 増分で値を調整します。マウ
スの左ボタンを使用して調整し、マウスの中ボタンを使用して微調整します。

■ クラウンを反転するには、点線をクリックします。

Crown Value

クラウンの高さをコントロールします。2 つのレイル間の距離の割合に対応する値です。スラ
イダの範囲は 0.0 から 0.1 までですが、これより大きな値をフィールドに入力することができ
ます。

Flip Crown

クラウンの方向を反転します。モデル上で直接クラウンの方向を反転するには、比例するクラ

ウンマニピュレータの矢印をクリックします。

Crown Type

12 | 第 3 章 モデリング



Central – V 方向の最初および最後の CV はドラフト角度、およびドラフトサーフェスの中央
にあるサーフェスクラウンに従います。

End – 最初の CV はドラフト角度に従います。クラウンの高さは、最後の CV から、ドラフト
角度に対して相対的に計測されます。
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新しい Multi-Surface Draft ツールオプションは、ドラフト/フランジをカーブオンサー
フェス(COS)にフィットさせます。

Explicit Controlの新しいオプションを使用すると、COS をフィットさせながら、ドラフト
を構築することができます。

Segmentation Option

NURBS – 非有理 NURBS カーブにフィットさせます。

Bezier – 非有理 NURBS カーブにフィットさせてから、スパンでデタッチしてベジェセグメ
ントを生成します。

Fitting Method

Surface UV – 基本サーフェスの U または V パラメータ配置に従います。これに失敗した場
合、COS は Curvature方法を使用してフィットされます。

Chordal – 円弧の長さに基づいてフィットさせます。各パラメータの手順は、3D の同等な手
順に対応します。Segmentation Optionが Bezier の場合、Alias は等間隔の CV を作成し
ようとします。

Parameter - カーブオンサーフェスのパラメータ配置に従わせます。

Curvature — 円弧の長さと曲率に基づいてフィットさせます。曲率が高い領域ほど CV が多
く配置されます。

Blend – Surface UVと Chordalのフィット方法のハイブリッド版です。UV to Chordal
Influence値が 0 の場合は、Surface UV方法を使用することと同等です。値が 1 の場合
は、Chordal方法を使用することと同等です。中間の値の場合、ポイント分布は 2 つのタイ
プのジオメトリ的な平均になります。

Stitch および Seam ツールの機能強化

■ Noneおよび Deckという 2 つの新しい継ぎ目タイプが追加されました。

None – 継ぎ目のないステッチを作成します。
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Deck – 「折り伏せ縫い」継ぎ目と同様な継ぎ目を作成します。

Deck継ぎ目のジオメトリ

Deck 継ぎ目タイプの場合は、Flip Seam Sideオプションを使用して継ぎ目が作成された
サーフェスの側を変更することができます。
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■ 新しい Add Jitterおよび Stitch Jitterオプションを使用すると、ステッチ角度にわず
かなバリエーションを追加して、さらにリアリスティックな外観を生み出すことができま

す。

Add Jitterが選択されていない

Add Jitterが選択されている、Stich Jitter値は 1

■ Seam Flipオプションの名前が Flip Surface Sideに変更されました。

Duplicate Curve ツールに追加された連続選択

カーブを複製するときに連続選択する機能が追加されました。

マスプロパティの改善

モデルのマスプロパティの計算および表示が次のように改善されました。

■ Mass Properties Options ウィンドウに、シーン内の重心ポイントロケータを作成するオプ
ションが追加されました。
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■ 単位変換が追加され、Mass Properties Editor に Litres、Gallons (UK)、および Gallons
(US)という 3 つの追加体積単位が追加されました。
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Cylinder および Cone ツールの改善

次数が 1 ～ 3 でなく、1 ～ 7 の円柱および円錐を作成できるようになり、非有理の場合の円の
精度が高まりました。

Surface From Mesh ツールの機能強化

■ Theoretical Surface作成モードで目的の領域のサーフェス出力の方向をコントロール
する新しいマニピュレータが追加されました。

サーフェスを作成した後で目的の方向にマニピュレータを回転して、更新します。

更新後に平面の方向を元の方向にリセットするには、マニピュレータの中央にある小さな

正方形をクリックします。

■ サーフェス作成のための明示的な U および V 次数コントロールが追加されました。
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リファレンスファイルの機能強化

リファレンスファイルが更新されてもリンクが保持されます。

旧バージョンの Alias では、更新された .wref ファイルを Wire ファイルが参照していた場
合、.wref ファイルに変更があったことを Alias が検知しユーザに通知していました。更新の
あったリファレンスファイルは .wire ファイルから削除され、手動で再読み込みする必要があ
りました。

Alias 2017 では、.wref ファイルが変更されたことを Alias が検知しユーザに通知した後に、更
新された .wref ファイルが自動的に読み込まれます。

変換とピボットの新機能

次の機能が追加されました。

■ 読み込まれたリファレンスファイルを変換する。

■ リファレンスファイルセット(読み込まれたすべてのリファレンスファイルのグループ)を

変換する。

■ 読み込まれたリファレンスファイルのピボットを設定する。

■ リファレンスファイルセットのピボットを設定する。

リファレンスファイルの変換は、リファレンスファイルセットに対して相対的に行われます。

変換は Wire ファイルと一緒に保存されます。

読み込まれたリファレンスファイルを変換するには

1 Reference Manager で、変換するリファレンスファイルを選択します。

リファレンスファイルセットを変換するには、Reference Filesを選択します。

2 Transformツールを使用してリファレンスファイルを移動、回転、およびスケールす

るか、Information Window の Transform Infoフィールドを更新します。

読み込まれたリファレンスファイルのピボットを設定するには

1 Reference Manager でリファレンスファイルを選択します。

リファレンスファイルセットのピボットを設定するには、Reference Filesを選択しま
す。

2 Set Pivotツールを使用してピボットを配置します。
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方向の機能強化

次のようにサーフェスのジオメトリ(UV)方向を設定および統一する機能が追加されました。

■ Set Surface Orientationが 2 つのツールに分割されました。

Set Visual Surface Orientation – U および V 方向に影響を与えることなく、カメラか
ら遠ざかる方向に、または近づく方向にサーフェスを合わせます。サーフェスを左クリッ

クすると、カメラに近づく方向にサーフェスを合わせることができます。サーフェスを中

ボタンでクリックすると、カメラから遠ざかる方向にサーフェスを合わせることができま

す。カメラの方向を向いているサーフェスはグレーで、カメラと反対を向いているサーフェ

スは黄色でシェーディングされます。

Set Geometric Surface Orientation – ジオメトリサーフェスの法線をカメラから遠
ざかる方向、または近づく方向に合わせます。サーフェスを左クリックすると、カメラに

近づく方向に法線を合わせることができます。サーフェスを中ボタンでクリックすると、

カメラから遠ざかる方向にサーフェスを合わせることができます。カメラの方向を向いて

いるサーフェスはグレーで、カメラと反対を向いているサーフェスは赤色でシェーディン

グされます。

■ 次の操作を実行できるように Unify Surface Orientationツールが更新されました。

■ サーフェスセットの視覚的な方向を統一します。これはこのツールの以前の動作です。

■ サーフェスセットのジオメトリック(UV)方向を統一します。

注: サーフェスの方向が統一されていることを検証するには、Multi Color ダイアグノス
ティックシェーダの Show Orientationオプションを使用します。チェックボックスは
Mode選択リストで置き換えられました。表示する方向を Off、Visual、または
Geometricの中から選択します。

■ Surface Edit > Reverse Surface UVは Surface Edit > Orientation > Reverse
Surface UVに移動されました。

サーフェスの方向を統一するには

1 Surface Edit > Orientation > Unify Surface Orientation❒の順に選択します。
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2 視覚的な方向を統一するには、Unify TypeとしてVisualを選択し、処理を進めます。

UV 方向を統一するには、Geometricを選択して操作を選択します。

Reverse U, V – U または V アイソパラメトリックカーブの方向をそれぞれ反転します。

Swap UV – U 向が V方向になる、またはその逆になるようにアイソパラメトリックカー
ブを入れ替えます。

3 一体化するすべてのサーフェスを選択してから、アクティブウィンドウの右下隅にある

Classifyボタンをクリックします。

4 Unifyをクリックします。

Geometricを選択した場合は、履歴を削除するように要求されます。

Multi Blend ツールの機能強化

Multi Blend ツールでは、Star Point およびその他のマニピュレータの移動を元に戻すことが
できます。

新しい Refit Surfaces ツール

リバースエンジニアリングプロセスを簡素化するためのイニシアチブの一環として、選択さ

れたサーフェスセットをスキャンしたメッシュに再フィットさせる Refit Surfaces ツールが追
加されました。再フィットされたサーフェスセットには、元のサーフェスセットの特徴(次数、

スパン、パラメータ配置)が維持されています。
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Refit前(左)、Refit後(右)

Refit前の偏差(左)、Refit後の偏差(右)

サーフェスをメッシュに再フィットさせるには

1 Surface Edit > Refit Surfaces ❒を選択します。

2 再フィットさせるサーフェスを選択して、Acceptをクリックします。

3 サーフェスを再フィットさせるメッシュを選択します。

4 必要に応じて再フィットオプションを調整します。

5 Buildをクリックします。

Refit Surfaces Control オプション

Refit Direction 再フィットの投影方向( Z Axis、Y Axis、X Axis、またはSurface
Normal)。

ほとんどの場合は、Surface Normalが有効です。
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注: 方向がサーフェス方向にほとんど平行な場合は、X、Y、または Z が機能しないことがあり
ます。

Minimum Degree 再フィット対象サーフェスの最小の次数です。再フィット対象サーフェス
の次数が指定した次数よりも小さい場合は、指定した次数まで次数が引き上げられます。

Smooth Smooth Factorに従ってサーフェスをスムーズ化します。

Smooth Factor 各スムージングステップの効果を制御します。Smoothing Factor を小さくす
ると、CV の移動が小さくなります。ノイズの多いスキャンの場合は、スムーズ係数を大きく
します。

Auto Update Refit Surfaces Control ウィンドウの値が変わった場合、サーフェスを自動的に
更新します。

Deviation Check サーフェスとメッシュ間の最大偏差を表示します。

Deviation Scale 偏差コームのスケールを設定します。
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データ変換

データ変換の変更点と新しい機能について説明します。

NX 書き出しトランスレータの新しいオプション

NX 書き出しトランスレータに次の 2 つのオプションが追加されました。

■ Layers to NX Categories – レイヤをカテゴリにマップします。

■ Zero Transform – すべてのオブジェクトに適用されたすべてのスケール、移動、および回
転をリセットします。

新しいオートデスクトランスレータ

Alias 2017 に DirectConnect は付属しません。代わりに新しいトランスレータが組み込まれま
す。Alias の 2 つ前のリリースからこれらのトランスレータが追加されるようになり、すべての
DirectConnect トランスレータの新バージョンが完成しています。

Alias のこのリリースには、次のトランスレータが追加されています。

■ CATIA V4

[Import]オプションの名前が[Convert]に変更されました(たとえば、Import Invisibleは
Convert Invisibleという名前になりました)。

CATIA 4 カーブ、サーフェス、シェル、ソリッドジオメトリデータを NURBS として Alias
に読み込む新しい Convert Nurbsオプションがあります。

■ CATIA V5

[Import]オプションの名前が[Convert]に変更されました(たとえば、Import Invisibleは
Convert Invisibleという名前になりました)。

新しいインポートオプション:

■ Convert Points

■ Convert Curves

■ Convert Geometric Sets (ジオメトリセットをレイヤおよびレイヤフォルダに変換)

4
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■ Granite

■ JT

BREP読み込みオプションは削除されました。

新しいインポートオプション:

■ Logfile Output

■ Convert Points

■ Convert Nurbs

■ Keep Topology

■ Shrink Surfaces

■ Level of Detail

■ STEP

新しいインポートオプション:

■ Logfile Output

■ Convert Meshes

■ Convert Points

■ Convert Curves

■ Convert Nurbs

■ Keep Topology

■ Shrink Surfaces

■ Convert Invisible

■ STL

新しいインポートオプション:

■ Logfile Output

■ Convert Colors

■ Color Schema

■ Input Units

EDF トランスレータの更新

EDF トランスレータでマテリアルおよびカラーがサポートされるようになりました。
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注: EDF マテリアルを読み込むと、Phong マテリアルとして読み込まれます。
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新機能の導入部分

新しいツール

このセクションに記載されているツールは、Alias のこのリリースの新機能です。
■ Curve Edit > Create > Freeform Curve Blend

■ Surface Edit > Refit Surface

■ View > View Flip

■ View > View Both

移動されたツール

このセクションに記載されているツールは、Alias のこのリリースで移動されています。

■ Surface Edit > Reverse Surface UVは Surface Edit > Orientation > Reverse
Surface UVに移動されました

廃止されたツール

次のツールは、冗長であるか、有用な用途が存在しなくなったために削除されました。

■ Surfaces > Boundary Surfaces > Skin 2012

5
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